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ความรูเบื้องตนการใชงานอนิเตอรเน็ต 

 อินเตอรเน็ต หมายถึงลักษณะของการเชือ่มตอของเครือขายคอมพิวเตอรทั้งเล็กและใหญจํานวนมาก
เขาดวยกัน โดยมีขอกําหนดวาทุกเครือขายที่เชื่อมตอถึงกัน จะตองอยูภายใตมาตรฐานของการเชื่อมตอ ที่
เรียกวา โปรโตคอล ซ่ึงถูกสรางขึ้นมาเพื่อใชงานบนเครือขายแบบนี้โดยเฉพาะ ซ่ึงเรยีกวา TCP/IP จาก
มาตรฐานการเชื่อมตอกันนี้เอง จึงมีผลทําใหเครือขายคอมพิวเตอรสามารถติดตอส่ือสารแลกเปลี่ยนขอมูล
ระหวางกันไดอยางรวดเรว็มปีระสิทธิภาพ และไมมีขีดจํากัดทางดานเวลาและสถานที่ 

WWW (World Wide Web) อาจเรียกสั้นๆ วาเว็บ เปรียบเสมือนเปนหองสมุดขนาดใหญที่รวบรวม
ขอมูลที่มากที่สุดในโลกกว็าได เราสามารถคนหาขอมูลที่ตองการไดเกือบทุกอยางจากบริการเว็บ ขอมูลใน
เว็บจะอยูในรปูแบบที่เรียกวา Hypertext และทําการเชือ่มโยง (Links) ขอความหรือ รูปภาพ เขากบัเอกสาร
อ่ืนๆ อยางเปนอิสระตอกัน ภาพหรือขอความที่แสดงบนหนาจอจะแสดงไดทีละหนา ซ่ึงเรียกวา เพจ (Page) 
หรืออาจมีการเชื่อมโยงดวยการลิงค (Links) เพื่อคนหาขอมูลจากอีกเพจหนึ่งที่อยูหางออกไปไกลๆได  

เว็บไซต (Web Site) เปรียบเหมือนเว็บเปนหองสมุดขนาดใหญ เว็บไซตจะเปรียบเสมือนหนังสือ
หนึ่งเลมในหองสมุดนั้น เราสามารถเลือกหยิบหนังสือเลมใดก็ไดในหองสมุดเว็บขึน้มาอานโดยระบุช่ือ
หนังสือในลักษณะที่เรียกวา URL (Universal Resource Locator - อานวา ยู อาร แอล)  เชน เว็บไซตของ
มหาวิทยาลัยกรุงเทพมี URL หรือมีช่ือเปน www.bu.ac.th หรือเว็บไซตของศูนยคอมพิวเตอรจะมช่ืีอวา 
compcenter.bu.ac.th เปนตน  

เว็บเพจ (Web Page) เอกสาร HTML ที่ใชเปนสื่อในการนําเสนอขอมูลบนอินเตอรเนต็ ซ่ึงจะตอง
อาศัยบราวเซอรในการแสดงผล 

โฮมเพจ (Home Page) หนาแรกของเว็บไซตที่ผูใชพบกอน เมื่อเปดเขาไปในเว็บไซตหนึ่งๆ ดวยการ
พิมพที่อยูของเว็บไซตลงในบราวเซอร 

เว็บบราวเซอร (Web Browser) โปรแกรมที่ใชในการแสดงเว็บเพจหรอืเอกสารประเภท HTML โดย
จะเปนตัวกลางที่ทําหนาที่แปลงคําสั่งกอนแลวแสดงผลคําสั่งใหออกมาเปนรูปภาพ เสียง และขอมูลตางๆ 
ตัวอยางบราวเซอรเชน Microsoft Internet Explorer, Netscape Navigator และ Opera 

DNS-Domain Name System คือ ระบบการตั้งชื่อบนอินเตอรเน็ต เนือ่งจากเครื่องคอมพิวเตอรที่ตอ
บนอินเตอรเนต็นั้นมีอยูจํานวนมากมายจึงตองมีหมายเลขประจําเครื่อง ซ่ึงหมายเลขนี้เรียกวา IP ซ่ึงจดจําได
ยาก จึงไดมวีิธีการตั้งชื่อใหจดจําและใชงานงาย และไดถูกกําหนดใหเปนมาตรฐาน โดยแบงตามลําดับขั้นตาม
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สภาพภูมิศาสตร เปนประเทศ ประเภทขององคกร และชื่อองคกร เชน www.bu.ac.th   th คือ ช่ือประเทศไทย   
ac คือ ประเภทองคกร    bu คือ ช่ือองคกร  

Domain ท่ีนิยมใชกันอยูในปจจุบัน เชน 
.com = กลุมธุรกิจการคา (Commercial) 
.edu  =  กลุมการศึกษา (Education)  
.gov  =  กลุมองคกรรัฐบาล (Government)  

ความหมายของ Sub Domain เชน 
.co  =  องคการธุรกิจ (Commercial)  
.ac  =  สถาบันการศึกษา (Academic)  
.go  =  หนวยงานรัฐบาล (Government)  
.or  =  องคกรอื่น ๆ (Organizations)  

Domain Name ชื่อยอของประเทศ เชน  
.th = Thailand  .hk = Hong Kong  
.jp = Japan   .sg = Singapore  

 
HTML ยอมาจาก Hyper Text Markup Language เปนภาษามาตรฐานที่ใชในการสรางเว็บเพจเพื่อ

นําไปแสดงผลในบราวเซอร ซ่ึงอาจจะประกอบดวยตวัอักษร กราฟก ลิงค และองคประกอบอื่นๆ เชน เสียง
และวดิีโอ  

สําหรับการสรางไฟล HTML ที่ผานมาจะตองอาศัยโปรแกรมที่มีคุณสมบัติเปน Text Editor โดยเรา
จะใชโปรแกรมเหลานี้สําหรับเขียนคําสั่งตางๆ หรือรายละเอียดของขอมูลที่ตองการใหแสดงผลบนจอภาพ 
และเก็บเปนไฟลโดยจะตองมีนามสกุลเปน .html จากนัน้ก็ทดสอบไฟลในโปรแกรมเว็บบราวเซอรตอไป แต
ในปจจุบนัไดมีการพัฒนาโปรแกรมที่ผูใชงานไมตองเขียนคําสั่งเองก็สามารถที่จะสรางเว็บเพจอยางงายๆ ได
เลย เชน Microsoft FrontPage, Netscape Composer, Macromedia Dreamweaver, Adobe Golive 

FTP (File Transfer Protocol) มาตรฐานในการสงผานขอมูลจากคอมพิวเตอรเครื่องหนึ่งไปยังอีก
เครื่องหนึ่ง เมื่อผูออกแบบไดสรางเว็บเสร็จแลว จะตองใชระบบ FTP นี้ในการอพัโหลดไฟลทั้งหมดไปเก็บ
บนเว็บเซิรฟเวอร 

 
ขั้นตอนในการพัฒนาเว็บไซต 

1. เตรียมเนื้อหาท่ีจะนําเสนอ กอนอื่นตองมีเปาหมายกอนวาจะทาํเว็บไซตเกี่ยวกับเรือ่งอะไรและเนื้อหา
ตางๆ มีอะไรบาง แลวจัดเตรียมสิ่งตางๆ ซ่ึงหมายถึง ขอความ, ภาพประกอบ, เสียง และอื่น ๆ 
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2. ออกแบบหนาตาของเว็บไซต วาตองการใหมีลักษณะเปนอยางไร เชน จะมีการแบงเฟรมหรือไม สี
ของ Background และตัวอักษรเปนสีอะไร จะจดัวางอะไรไวตรงสวนไหน จะมี Link ที่ใดบางและแต
ละ Link เชื่อมโยงไปหาสวนใด เปนตน 

3. เขียนและทดสอบ ลงมือเขียนโดยใชโปรแกรมสําหรับเขียนเว็บไซต แลวทําการทดสอบการแสดงผล
และ Link ตางๆ วาเชื่อมโยงไดถูกตองหรือไม ในขั้นตอนนี้ถามีปริมาณขอมูลมากและมีการเชื่อมโยง
ที่ซับซอนก็จะใชเวลาคอนขางมากเพราะตองคอยปรับแกอยูเร่ือย ๆ 

4. ลงทะเบียนชื่อเว็บไซตและจัดหาพื้นท่ีเก็บขอมูล นักศึกษามหาวิทยาลยักรุงเทพทกุคนจะมีช่ือเว็บไซต
และพื้นทีเ่ก็บขอมูลอยูแลวโดยไมตองลงทะเบียนเพิ่มเติมแตอยางใด ตามตัวอยางดังนี ้ 

   Login: 1450100241 จะมีชื่อเว็บไซต http://tulip.bu.ac.th/~1440320115/  
   พ้ืนที่เก็บขอมูลสําหรับทําเว็บไซต 10 MB 
5. นําเว็บไซตท่ีสรางขึ้น Upload ขึ้น Server และตรวจสอบความเรียบรอย คือการคัดลอกขอมูล จาก

เครื่องของเราไปเก็บไวในเครื่อง Server ซ่ึงการคัดลอกนีเ้รียกวา Upload โดยใชโปรแกรมสําหรับการ 
Upload เชน โปรแกรม CuteFtp, WS_FTP (โปรแกรม Dreamweaver มีความสามารถนี้อยูแลว) 

6. ประกาศใหโลกรับรู เมื่อตรวจสอบความเรียบรอยแลว กถึ็งคราวที่จะชกัชวนใหผูคนมาชมเว็บไซต
ของเรา โดยประชาสัมพันธผานทางสื่อตางๆ เชนแลก Link กับเว็บไซตอ่ืนๆ ฝากขอความชักชวนไว
ตามกระดานขาวตางๆ หรือจะเพิ่มชื่อเว็บไซตของเราใหกับแหลงรวมขอมูลบนอินเตอรเน็ตอยาง 
yahoo  

ขอแนะนําในการทําเว็บไซต  
1. การเลือกเนื้อหาเว็บไซต ถือเปนสวนสําคัญในการเริ่มตนทําเว็บไซต ทั้งการจัดโครงสราง และ ความ

นิยมของเว็บไซต  สําหรับผูเร่ิมตน ซ่ึงไมแนใจวาจะเลือกหัวขอใด ควรเริ่มตนจาก การสํารวจตัวเอง
วา ชอบ หรือ สนใจสิ่งใด มากที่สุด หรือ มีความรูเชี่ยวชาญดานใดมากที่สุด  

2. โครงสรางของเว็บไซต  มีจุดมุงหมายสําคญัคือ การที่จะทําให ผูเขาเยีย่มชม สามารถคนหาขอมูล ใน
เว็บไซตไดอยางเปนระบบ ประการแรกตองพิจารณาถึง ความเปนไปไดของประเภทของผูเขาเยี่ยมชม 
เพราะผูเยีย่มชมแตละประเภท ก็จะคนหาขอมูลที่แตกตางกัน ดังนัน้สิ่งที่ควรจะทําก็คือการจัดกลุม
ของขอมูลโดยใหรวมหัวขอยอยตางๆ ใหอยูในหัวขอหลัก โดยมีจดุมุงหมายให จํานวนขอหลักนอย
ท่ีสุด นอกจากนี้การจัดไฟลและไดเร็กทอรี่ ก็จะชวยใหการดูแลรักษาและการตรวจสอบความ
ผิดพลาดของเว็บไซตงายยิ่งขึ้น เชน การจดัไฟลรูปภาพไวที่เดยีวกัน หรือ จัดเว็บไซตที่เปนเรื่อง
เดียวกันไวในไดเร็กทอรี่เดยีวกัน เปนตน 

3. สามารถดูเว็บไซตไดในหลายบราวเซอร การทําเว็บไซตควรจะทําเพื่อใหสามารถดูไดจากทุกๆ 
Version ของ Software ตางๆ ไมวาจะเปน Netscape Communicator Internet Explorer หรือ อ่ืนๆ การ
ทําใหทุกคนดไูดนี้ ถือวาเปนการขยายฐานของผูเขาเยี่ยมชม  
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4. ความเร็วในการโหลดเว็บไซต สําหรับหนาแรกของเว็บไซตไมควรใหโหลดขอมูลชา ปจจัยทีจ่ะ
กระทบตอความเร็ว ไดแก ขนาดของรูปภาพที่ใช จํานวนของรูปภาพที่ใช และปริมาณของตัวอักษรที่
อยูบนหนานั้นๆ อนึ่งความเร็วในการโหลดเว็บไซต อาจอยูที่ Server ที่เวบ็ไซตนั้นๆอยูวามี
ความสามารถสูงเพียงใด ขนาดของรูปภาพที่ใชควรจะมีขนาดไมเกิน 20-30K ตอรูป สวนประเภทของ
รูปนั้นควรเปน GIF หรือ JPEG ถาขนาดของรูปภาพใหญเกินไป อาจตัดแบงใหขนาดเล็กลง และใช
ตารางชวยในการจัดรูปภาพนั้นๆ  

5. ความงายในการคนหาขอมูล ปจจัยหลักนั้นขึ้นอยูกับโครงสรางของเว็บไซตตั้งแตตอนแรกที่มีการจดั
โครงสรางและจัดกลุมของขอมูล นอกจากนี้ยังมีปจจัยอ่ืนๆ อีกเชน การมี Navigator bar หรือ แถบนํา
ทาง ในทุกๆหนาของเว็บไซต และถาสามารถใหบริการ Search และ Sitemap ไดกจ็ะเปนสิ่งที่จะชวย
ใหคนหาขอมูลไดงายยิ่งขึน้  

6. ตัวอักษร, ฉากหลัง และ สี สําหรับรูปแบบที่นิยมใชคือ ตวัอักษรสีดํา บนฉากหลังขาว ถาตองการ
กําหนดประเภทของตัวอักษรควรใชที่เปนสากลนิยม เชน ในกรณภีาษาอังกฤษ อาจใช Arial หรือ 
Times News Roman เปนตน สวนภาษาไทย อาจใช MS Sans Serif การเลือกใชตัวอักษรภาษาไทยนั้น
ตองระวังเปนพิเศษเพราะในกรณีที่เครื่องผูเยี่ยมชมไมมตีัวอักษรนั้นๆ อาจทําใหผูเขาเยี่ยมชมไม
สามารถอานตัวอักษรไดเลย  

7. รูปภาพ ที่ใชม ี2 ประเภทคือไฟลกราฟกประเภท GIF หรือ JPEG ในปจจุบันไฟลประเภท PNG ก็มี
บางเว็บใชเชนกัน หนึ่งในหลักการพิจารณาการใชประเภทเพื่อประสิทธิภาพสูงสุด คือ จํานวนสีของ
รูปภาพนั้นๆ ถาเปนภาพแตงหรือภาพถายที่มีสีมากๆ ก็ควรใชไฟลประเภท JPEG แตถาเปนเพียงปุม
หรือปายที่มีสีไมมากก็ควรใช GIF พรอมกบัพิจารณาเรื่องขนาดของไฟลดวย อนึ่งควรจะมีการคะเน
ขนาดของรูปภาพที่จะใสบนเว็บไซตกอน เพื่อจะไดใชขนาด และ อัตราสวน ที่พึงพอใจมากที่สุด  

8. สวนประกอบที่ขาดไมไดของเว็บไซต เชน หัวขอที่เกี่ยวกับผูจัดทํา อาจเปนประวัติความเปนมา และ/
หรือ ขอมูลปจจุบัน (About us) เหลานี้ชวยเพิ่มความนาเชือ่ถือใหกับผูเขาเยี่ยมชม และเพิ่มเติมเกีย่วกบั
แถบนําทาง Search Sitemap และยังมหีัวขออ่ืนๆ อีก เชน ขอเสนอแนะ (Feedback) คําถามที่ถูกถาม
บอย (FAQ - Frequently Asked Questions)  

9. กอนท่ีจะนําเว็บไซต  Upload ไปยงั Server ควรจะมีการทดสอบ โดยใชทั้ง Netscape Communicator 
และ Internet Explorer เพื่อดูความเร็วในการโหลดวาชาหรือเร็วเพยีงใด Link ทั้งภายใน และ ภายนอก 
ถูกตองหรือไม รูปภาพถูกตองหรือไม พิสูจนอักษร และอานขอมูล เพื่อใหแนใจวาขอมูลตางๆ ถูกตอง  

10. หลังจากที่เว็บไซต  Publish ถาเปนไปไดควรทดสอบ เหมือนกับที่ทดสอบกอนที่จะ Publish เพื่อความ
แนใจอีกครั้ง นอกจากการทดสอบแลว ส่ิงที่จะตองกระทาํหลัง Publish คือ การสํารวจ ปรับปรุง และ 
ดูแลรักษาเว็บไซต เมื่อพบความคิดดีๆ ที่อาจนํามาปรับปรุงเว็บไซตไดก็ควรจะจดบนัทึกไว ถาเปนการ
แกไขนดิหนอยก็ควรทําการแกไขทันที แตถาเปนการแกไขที่ตองใชเวลานานควรรอสักระยะรวบรวม
ส่ิงที่ตองการแกไขทั้งหมด  
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แนะนําโปรแกรม Macromedia Dreamweaver MX 
Macromedia Dreamweaver MX เปนโปรแกรมสรางโฮมเพจแบบเสมือนจริง โดยไมตองเขียน

ภาษา HTML เอง หรือที่ศัพทเทคนิคเรียกวา "WYSIWYG" โปรแกรม Dreamweaver มีคุณสมบัติแบบลาก
แลววางและมีเครื่องมือ ชวยในการสรางโฮมเพจอยางครบครัน และที่สําคัญคือ สามารถทํางานรวมกับ
ภาษาไทยไดอยางดี เมื่อเปดโปรแกรมขึ้นมาจะมีสวนประกอบตางๆ ดังรูป 
Menu สําหรับเรียกใชคําสั่งตางๆ โดยคลิกชื่อเมนูที่ตองการทํางาน 

 
สวน Object เปนเครื่องมือที่ใช Insert Tag คําสั่งตาง ๆ ลงในโฮมเพจ เชน ใสรูปภาพ ใสตาราง สรางเลเยอร 
เปนตน โดยสามารถที่จะเปลี่ยนไดอะล็อกได โดยคลิกที่ Tab ของ Object แตถาไมตองการใหสวนของ Object 
นี้ปรากฏสามารถทําไดโดยกดที่                           สวนนี้กจ็ะถูกยอเก็บไป

 
HTML Code Inspector สวนของ Code และการจัดการไฟล เปนการออกแบบเว็บไซตที่สามารถดูรูปแบบได
เหมือนของจรงิที่ปรากฏบนเว็บเพจหรือตองการเขียน Code เปนภาษา HTML เพื่อจัดการไฟล โดยแตละปุมมี
หนาที่ดังนี ้

 
  Show Code View คลิกเพื่อดู Code ภาษา HTML ทั้งหมดของไฟล 

Show Code and Design คลิกเพื่อดู Code ภาษา HTML และดูรูปแบบเหมือนจริงของเว็บเพจ 
โดยแบงครึ่งหนาจอในการแสดงผล 
Show Design View คลิกเพื่อดูรูปแบบเหมอืนจริงของเวบ็เพจ 

 
สวนสําหรับใส Tile ของเว็บเพจ   
 
สวนการ Preview/Debug in Browser       
เปนการดูรูปรางหนาตาที่ไดออกแบบบนเว็บ  
Browser ในที่นี้คือ Internet Explore หรือกดปุม F12 
 
Tab File เมื่อเปดไฟลหลายๆ ไฟลเพื่อทํางาน ทุกไฟลทีเ่ปดอยูจะอยูในโปรแกรมเดยีวโดยทําเปน Tab ไว
ดานลางจะเลือกใชไฟลใดกก็ดที่ Tab นั้น
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Properties เปนการแสดงสถานะของ Object หรือ Tag ตางๆ โดยจะคอยติดตามการทํางาน ทั้งนี้ก็เพื่ออํานวย
ความสะดวกใหทํางานไดงายขึ้น เชน ถา Click ที่รูปภาพก็จะเปลี่ยนสถานะเปน Image Inspector แสดงขอมูล
ของรูปภาพนัน้ แตถา Click ที่ link ก็จะแสดงขอมูลของ link นั้น โดยสามารถแกไขคาตางๆ ของ Object หรือ 
Tag ตางๆ ไดงาย ถาหากไมตองการใชงานสามารถยอเก็บไดโดยคลิกที่  

 
 
สวนของหนาตางดานขวา แบงเปนสวนตางๆ ตามหนาทีก่ารใชงาน ดังนี้ 

1. Design การใสลูกเลนตางๆ เพิ่มเติมสีสันใหกับเว็บเพจ 
2. Code เปนการกําหนดคาตางๆ และกําหนดคุณสมบัติของ 

Tag HTML 
3. Application เปนการจัดการดาน Programming 
4. Files จัดการเกีย่วกับไฟลทั้งหมดใน Site การ Upload 

ไฟลเขาสู Server 
5. Answers คูมือการใชงาน Dreamweaver MX 

 
 
 
 

 
เคร่ืองมือจัดการและบริหารเว็บไซต 

 เนื่องจากในการทําเว็บไซตหนึ่งๆนั้น จะประกอบไปดวยหนาโฮมเพจหลายๆหนา มีไฟลจํานวนมาก 
และแตละหนาก็จะมีลิงคเชือ่มโยง มีเนื้อหาที่ตอเนื่องถึงกันอยู ดังนั้นเพื่อไมใหเกดิความสับสนผิดพลาด 
Dreamweaver จึงมีเครื่องมือที่มีคุณสมบัติในการจัดการบริหารเว็บไซตซ่ึงจะชวยในการทํางานไดอยางดี  
การกําหนดไซต 
 ส่ิงที่สําคัญในการใชงาน Dreamweaver คือ จะตองสรางโฟลเดอรไวสําหรับการจัดเก็บไฟลโฮมเพจ
ทั้งหมดไวเพื่อใหการทํางานเปนระบบ ดังนั้นผูใชงานควรจะกําหนดชือ่ไซตพรอมกับระบุตําแหนงที่ตั้งหรือ
โฟลเดอรของไซตนั้นๆ กอนเสมอ ไมวาเว็บไซตจะมีเพยีงโฮมเพจเพียงหนาเดยีว หรือหลายหนากต็าม โดย
ขั้นตอนในการกําหนดไซตมีดังตอไปนี ้

คลิกเพื่อยอหนาตางดานขวา 
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1. คลิกเมนู Site เลือก New Site หลังจากนัน้คลิก Tab Advanced เพื่อกําหนดชื่อพรอมทีต่ั้งของไซต โดยใส
ขอมูลตรงชอง Site Name เพือ่ตั้งชื่อ Site สวนของ Local Root Folder ใหคลิกปุม  เพือ่กําหนดที่ตั้ง
สําหรับเก็บไฟล 

 
 

2. จากนั้นจะขึน้วินโดวดังภาพดานลางให Click ปุมและตั้งชื่อโฟลเดอรสําหรับเก็บไฟล คลิกเลือกโฟลเดอร
ที่ตองการเก็บไฟล กดปุม Open ดานลางจอ เพื่อเขาสูโฟลเดอรนั้นและกดปุม Select ที่หนาจอดานลาง 
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3. หลังจากคลิกปุม Ok แลวจะกลับมาสูหนาการทํางานของโปรแกรม โดย Site ที่ผูใชงานสรางไวสามารถดู

ไดจากหนาตางดานขวามือสวนของ Files จะแสดงรายละเอียดของไฟล โฟลเดอรตางๆ  
 
 
 

 
 
 
 
 
 
 
 

สรางไฟลเอกสารขึ้นมา 1 ไฟล โดยการ Click ที่ File > 
New File และให Save ช่ือ index.html ซ่ึงไฟลนี้จะเปน
เว็บเพจหนาแรกของเว็บไซตซ่ึงจําเปนตองตัง้ชื่อ File 
เปน index.html เสมอเพราะ Browser จะอาน File 
index.html กอนเปนอันดับแรก และหลังจากนั้นถึงจะ 
Link ไปยัง File งานอื่นซึ่งจะตั้งเปนชื่ออะไรก็ได โดย
ตองมีนามสกุลเปน .html  
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4. ควรมีการตั้งโฟลเดอรสําหรับเก็บภาพที่ใชในเว็บไซตเพือ่ไมใหปะปนกับไฟล HTML ที่ผูใชไดสรางไว 

เชน สรางโฟลเดอร images (สัญลักษณของโฟลเดอร  ) สําหรับวิธีสรางโฟลเดอรใหคลิกขวาที่ Site 
ซ่ึงผูใชไดสรางไวแลว จะปรากฏเมนูขึ้นมาคลิกที่คําสั่ง New Folder ก็จะไดโฟลเดอรใหมและเปลี่ยนชื่อ
โฟลเดอรตามที่ตองการ 

 
 

 

*** การตั้งชื่อไฟล  ขอควรระวังสําหรับการตั้งชื่อไฟลสําหรับใชใน Server ของมหาวทิยาลัย  
- หนาแรกของเว็บไซตตองบนัทึกชื่อเปน index.html เสมอ 
- ตั้งชื่อไฟลเปนภาษาอังกฤษทัง้หมด และเปนตัวอักษรตัวเล็ก 
- ไมใหมีชองวางระหวางชื่อไฟล หรือถาตองการเวนชองวางควรใชเครื่องหมาย _ แทน 
- เมื่อมีการ Save ไฟลใหพิมพนามสกุลของไฟลเปน .html เสมอ  
- สําหรับภาพทีใ่ชในเว็บไซตนามสกุลของไฟลเปน .jpg .gif หรือ .png และตองบันทกึเปน

ช่ือภาษาอังกฤษทั้งหมด และเปนตัวอักษรตวัเล็ก เชน home.jpg  button.gif 
ตัวอยางการตั้งชื่อไฟล aboutme.html    index_profile.html   couse325.html 
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การกําหนดคณุสมบัติของหนาโฮมเพจ 
1. คลิกเมนู Modify เลือกคําสั่ง Page Properties จะปรากฏหนาจอดังภาพ ที่ชอง Title ดานบน พิมพขอความ

เพื่อเปนชื่อหวัเร่ืองของหนาโฮมเพจ ซ่ึงจะปรากฏอยูบนแถบดานบนของบราวเซอร  

 
หรือจะพิมพ Title ที่สวนของ HTML Inspector ก็สามารถทําไดเชนกัน 

 
 
Background Image เปนการใชรูปมาทําเปน background ถารูปมีขนาดเล็กทางโปรแกรมจะจัดเรยีง

เปน Pattern เรียงรูปซ้ํากันเปนแบบตาราง 
การกําหนดคณุสมบัติเก่ียวกับการแสดงสบีนหนาจอ มีดังนี ้

• สีพื้นฉากหลัง (Background) 
• สีตัวอักษรทัว่ไป (Text) 
• สีตัวอักษรลิงค (Link) 
• สีตัวอักษรลิงคของหนาโฮมเพจที่เคยดูมาแลว (Visited Link) 
• สีตัวอักษรลิงคขณะคลิกเมาส (Active Link) 
โดยคลิกในชองสี่เหล่ียมดานหลังขอความ Background ก็จะปรากฏพาเล็ตตสีขึ้นมาใหเลือกสี โดยจะ

มีสีใหเลือกทั้งหมด 216 สี เมื่อเลือกไดสีที่ตองการแลวก็คลิกเมาสอีกหนึง่ครั้ง ซ่ึงภายในพาเล็ตตสีจะมีปุม
เล็กๆ อยูสามปุมดวยกัน คือ 
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• Eyedropper เปนตัวช้ีเมาสรูปหลอดหยดสี ที่ทําหนาที่สําหรับเลือกสีที่ตองการบนจอภาพ 
• Eraser เปนปุมสําหรับการยกเลิกการเลือกสีที่เลือกไวกอนหนานี้ เหมือนปุม Cancel 
• Color Button สําหรับแสดงพาเล็ตตที่ละเอียดขึ้น  
เมื่อกําหนดคณุสมบัติทั้งหมดใน Page Properties เรียบรอยแลว ใหคลิก OK ก็จะเหน็วาสีของ

ตัวอักษรในหนาโฮมเพจนีไ้ดเปลี่ยนไปแลว 
 

 
 

การพิมพตัวอักษร 
การพิมพตัวอักษรและขอความ 

การพิมพตัวอักษรและขอความใน Dreamweaver เหมือนกับการใช Microsoft Word  
เราสามารถพิมพเขาไปในหนา Document ไดเลย และลอง Preview ดูโดยการกด F12 (เปนการจําลอง 
Browser) เราจะเหน็ไดวา ตัวอักษรที่พิมพจะเหมือนกันกบัที่ Preview ทุกประการ  
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การปรับรูปแบบตัวอักษร 
การปรับรูปแบบตัวอักษรสามารถทําได โดยใช Properties Inspector Tool  

 
• Format เปนรูปแบบของอักษรสามารถเลือกไดตามตองการ 

-  Paragraph การพิมพแบบตอเนื่อง 
-  Heading 1-6 การพิมพหวัขอเร่ืองตามขนาด Heading 1 เปนขนาดใหญที่สุดเรียงตามลําดับ 
เปนการใชเลือกกอนพิมพ แตถาพิมพไปแลวจะใชไดโดยการ Click Mouse คางแลวปายทั้ง
ขอความที่ตองการจากนัน้มาเลือกที่ Properties > Format ตัวอักษรก็จะเปลี่ยนตาม สวนตัว
อักษรที่ไมไดเลือกก็จะไมมกีารเปลี่ยนแปลง 

-  ในหนา Document เดียวกนัเราสามารถใช ตัวอักษรหลายแบบโดย Click ที่ลูกศรในชอง 
Default Font จะมี Font อ่ืนใหเลือก สวนคา Default Font จะเปน Font ที่ไดทําการ Set ไวใน
ตอนตน ซ่ึง Font ที่นิยมใชและสามารถอานภาษาไทยไดคือ Ms Sans Serif, Verdana (สามารถ
กําหนด Font ไดมากกวา 1 Font) 

• Size ขนาดของตัวอักษร คลิกที่  
• การใชตัวหนา และตัวเอน ตวัหนา Click ที่ และตัวเอน Click ที่  

ตําแหนง Cursor เพื่อเร่ิมพิมพขอความ 
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• การจัดให ชิดซาย ชิดขวา หรือกึ่งกลาง (เหมือน Word ทุกประการ)  
• การใชหวัขอยอย จะเปนจดุหรือตัวเลขก็ได 
• เปลี่ยนสีตัวอักษรโดย Click ที่ชองสี่เหล่ียมจะมีจานสีใหเลือก 
 

 
ขอจํากัดของการพิมพตัวอักษร 
• เนื่องจากการพิมพไมสามารถเวนวรรคตวัอักษรไดเกนิหนึ่งตวัอักษร จึงตองมีการเพิ่ม Code ลงใน

โปรแกรม คือ คําสั่ง &nbsp; สําหรับการเวนวรรค 1 ตัวอักษร หรือคลิกจากแท็บ Insert 
 

 
 

 
 
• การขึ้นบรรทัดใหมโดยการเคาะ Enter ในโปรแกรมจะเปนการเวน 2 บรรทัด  

ถาหากตองการเวนหนึ่งบรรทัดสามารถทําไดโดยการกด Shift คางพรอมทั้งกด Enter  
 

1. เลือก Characters 

2. เลือก Non-Breaking Space 
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การใสรูปภาพ 
1. คลิกปุม Image บนแท็บ Insert ดังรูป หรือคลิกเมนู Insert แลวเลือกคําสั่ง Image  

จะปรากฏหนาตางดังรูป ซ่ึงการเลือกรูปภาพมีจากหลายแหลงที่ตองการ ดังนี ้
• เลือกรูปภาพจากโฟลเดอรอ่ืนที่ไมไดอยูภายใต Site ที่ผูใชกําหนด เชน ตองการเลือกภาพจาก 

Drive C โฟลเดอร Gallery ดังรูป 

 
 กดปุม OK หลังจากนั้นจะปรากฏหนาตางดงัรูป โดยโปรแกรมถามวาตองการคัดลอกรูปภาพมา Site 
ที่ผูใชสรางไวหรือไม ใหกดปุม Yes เพื่อคัดลอกรูปภาพ 

 
 หลังจากนัน้โปรแกรมจะขึน้หนาจอใหเลือกโฟลเดอรที่ตองการคัดลอกลงภายในไซตที่ผูใชกําหนด
ไวตอนแรก โดยเริ่มแรกผูใชสรางโฟลเดอร images สําหรับเก็บรูปภาพไวแลว จึงใหดับเบิลคลิกที่โฟลเดอร 
images เพื่อเกบ็รูปภาพที่คัดลอกมาไวภายใตโฟลเดอรนัน้ และกดปุม Save รูปภาพที่เลือกไวก็จะปรากฏ 
 

คลิกเพื่อเลือกโฟลเดอรที่ตองการ 
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• เลือกรูปภาพจาก Drive A หรือแผนดิสก ใหคลิกที่ปุมลูกศรเพื่อเลือก Drive A และคลิกชื่อไฟล

รูปภาพที่ตองการคัดลอก หลังจากนั้นใหปฏิบัติตามขั้นตอนขางตน 

 
     เมื่อใสรูปไดแลวและตองการจัดรูปใหอยูกึง่กลางของหนาจอ หรือกําหนดคุณสมบัติเพิ่มเติมเกีย่วกบั
รูป ใหคลิกรูปภาพนัน้ และกาํหนดคณุสมบัติตางๆของรูป โดยใช Properties  
 

 

   ปรับความกวาง(W) 

กําหนดตําแหนงของรูปภาพ 

 แสดงที่เก็บไฟลรูปภาพ ใสช่ือของรูปภาพ ใสขอความกํากับภาพ 

กําหนดเชื่อมโยงภาพไปยังขอมูลหรือเว็บไซตอื่น 
   ปรับความสูง(H) กําหนดกรอบของรูปภาพ 

ดับเบิลคลิกที่โฟลเดอร images เพื่อเก็บ
รูปภาพที่คัดลอกมาไวภายใตโฟลเดอรนั้น 
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การทําลิงค (Link) 
Link ลิงคสามารถแยกเปนประเภทใหญๆ ไดสองประเภทคือการลิงคแบบ 

• Absolute Link : เปนลิงคที่ตองอางอิงขามระหวางโดเมน เชนการลิงคไปยังเว็บไซตอ่ืน และจะตอง
ระบุช่ือโดเมนทั้งหมด เชน ทําการลิงคไปที่ Bangkok University ตองระบุคือ http://www.bu.ac.th ถึง
จะสามารถลิงคได 

• Relative Link : เปนการลิงคภายในเว็บไซตของเราเอง 
การทําลิงคสามารถจะทําไดหลายวิธีและสามารถที่จะลิงคไปยังหนาอื่นหรือหนาเดียวกันก็ได 

การทําลิงคขอความ 
เปนการลิงคที่งายและไมยุงยาก กอนที่จะทาํลิงคจําเปนตองสรางไฟลที่เปนเปาหมายที่ลิงคไป 

1. พิมพขอความที่ตองการทําเปนลิงค เชน About Me  
2. ทํา Highlight ขอความ About Me 
3. ที่ Properties inspector ในชองลิงคใหคลิกที่สัญลักษณรูปโฟลเดอรดังรูปดานลาง 

 

 
4. เลือกไฟลที่ตองการลิงคไป เชน  aboutme.html แลวคลิก OKทดสอบคลิกลิงคที่ไดทําไว โดย

การกด F12 เพือ่ดูผาน Browser  

3. คลิกเลือกไฟลท่ีตองการจะลิงคไป 

2. ทํา Highlight ขอความ 
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การลิงคไปยงัเว็บไซตอ่ืน  
เราสามารถที่จะทําเว็บของเราเปนเว็บบรกิารหรือรวมลิงคใหผูอ่ืนสามารถลิงคไปยังเวบ็ไซตอ่ืนไดอีก

ดวยเพื่อสรางความหลากหลายในเว็บของเรา และยังสะดวกกับเจาของเว็บเองอีกดวยโดยไมตองพิมพ URL 
เขาไปใหม แตสามารถคลิกที่เว็บของตัวเองก็สามารถไปยังเว็บที่ตองการได เราอาจจะทําลิงคเฉพาะเว็บที่เรา
ใชบอยๆ เชน เว็บไซตของมหาวิทยาลัย เวบ็ URSA เปนตน  
ขั้นตอนการทําลิงค  

• พิมพขอความที่ตองการทําลิงค เชน Bangkok University 
• จากนั้นใหปายทับขอความ Bangkok University และมาที่ Properties inspector ในชอง Link ให

พิมพ URL เขาไปคือ http://www.bu.ac.th 
• กด F12 เพื่อดผูาน Browser  ใช Mouse ช้ีที่ขอความ จากนั้นใหสังเกตจาก Status bar  

ดานลางจะระบุเว็บไซตที่ถูกเชื่อมโยง แลวทดสอบคลิกที่ลิงคที่ทําไว 
 

 

 

 
 
 
 

2. Status Bar แสดง URL ของ Website ที่จะลิงคไป 

1. เมื่อนํา Mouse 
 มาไวที่ลิงค 
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การทําลิงคเมล (E-mail Link) 
การทําลิงคเมลสวนมากจะเปนการใหผูทีช่มเว็บไซตไดติดตอกับเจาของเว็บไซต กลาวคือเปนการสง

เมลธรรมดานั้นเอง แตพเิศษอยูที่ผูชมไมตองพิมพที่อยู E-mail Address ของเรา เพียงพิมพขอความติชมเทานั้น 
เหมือนเปนการสงเมลอัตโนมัติโดยไมตองไปที่ผูใหบริการเมล โดยหลังจากคลิกลิงคเมล Browser จะเปด
โปรแกรมสงเมลใหโดยอัตโนมัติ สวนมากถาเปน IE จะเปดโปรแกรม Outlook ให 
วิธีลิงคเมล 

• พิมพขอความที่ตองการลิงคไปยัง E-mail เชน Email หรือ คําวา ”Contact me” 
• จากนั้นใหปายทับ E-mail Address และมาที ่Properties inspector ในชอง Link ใหพิมพ  

E-mail Address ที่ตองการทําลิงค เชน mailto:siriporn.k@bu.ac.th 

 
• หรืออีกวิธีคือเลือก Object ที่ Email Link ภายในแท็บ Insert ใหกําหนดดังนี ้

• จะปรากฏ Dialog Box ดังรูป 
Text ใหใสขอความ คําติชม 
E-mail ใหใสที่อยูของเมล 
คลิก OK 
 

• จากนั้นทดสอบโดยการกด F12 แลวคลิกขอความ จากนั้นโปรแกรมจะเรียกโปรแกรม Outlook 
ขึ้นมาใหใสขอความ จากนัน้คลิกสง (send) 

การใชรูปภาพเปนลิงค 
• คลิก Image จากแท็บ Insert 
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• เลือกรูปจาก Dialog box คลิก OK 

 
• คลิกที่รูปภาพที่ Insert มา และที่ Properties ในชองลิงคใหคลิกปุม       จากนั้นเลือกไฟลที่

ตองการลิงคไปหาหรือจะลิงคไปยังเว็บไซตอ่ืนภายนอก 
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การทําลิงคในหนาเดียวกัน 
Anchor Name  

เปนการลิงคภายในเว็บเพจเดียวกัน ใชในกรณีที่มีหวัขอยอยหลายหวัขอและแตละหวัขอมีเนื้อหามาก 
เพื่อชวยใหสะดวกในการคนหาหรือเขาถึงขอมูล 
ขั้นตอนการทํา 
• พิมพขอความที่ตองการ เชน 

• ตั้งชื่อ Anchor  
• คลิกเมาส ณ ตาํแหนงที่ตองการตั้ง Anchor Name 
• คลิก             ในแท็บ Insert  
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• Dialog box ใหตั้งชื่อเปนชือ่ที่ส่ือใหเรารูวาคืออะไร  และคลิก OK  

 
• การทําลิงค 

• พิมพขอความที่ตองการทําลิงค เชน 

• ปายทับขอความและมาที่ Properties inspector ในชอง Link ใหพิมพ # ตามดวยช่ือ Anchor ที่ตั้งไว 
เชน Pic1 

 
 
 
 
 
 
 

 
 
• กด F12 และลองคลิกที่ลิงค สังเกตวาหลังจากที่คลิก หนาเพจจะเลื่อนมายัง Picture ที่ไดทําลิงคไวโดย

อัตโนมัติ 
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ตาราง (Table) 
 
การสรางตาราง 
1. เลือกตําแหนงที่ตองการใสตาราง ดวยการวางเคอรเซอรที่ตําแหนงนั้น 
คลิกปุม Table ในแท็บ Insert หรือเลือกเมนู Insert > Table  

 
 

2. จะมี Dialog box ขึ้นมาใหกําหนดขนาดตารางและคาตางๆ 

 
Rows  จํานวนแถวแนวนอน 
Columns  จํานวนคอลัมน (แนวตั้ง) 
Width   ขนาดของตารางโดยรวม เลือกไดวาจะใหหนวยเปน percent หรือ Pixel 
Border   กรอบของตาราง 
Cell Padding  ชองวางระหวาง Cell กับตัวอักษรในเซลล 
Cell Spacing  ชองวางระหวาง Cell  
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3. Click OK จะมีตารางที่กําหนด ปรากฏที่หนา Document ดังภาพ 

 
4. ถาตองการปรับขนาดของตาราง ทําไดโดยการคลิกทีข่อบของ Table ซ่ึง Properties inspector จะเปลี่ยนไป
แสดงคุณสมบตัิ (Properties) ของตาราง 
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Select table element  
  ตารางสามารถเลือกสวนที่จะเซ็ตคาตางไดหลายแบบ โดยจะเลือกแกไขทั้งตาราง หรือแกไขทีละชอง 
หรือ แกไขทีละแถว หรือที่ละคอลัมนก็ได  
การเลือกท้ังตารางเพื่อแกไข 
  คลิกที่ขอบดานใดดานหนึ่งของตาราง หรือ คลิกในตารางสวนใดก็ไดหนึ่งครั้ง แลวคลิกขวาที่เมาส
เลือก Table > Select Table 

 
 
 

การเลือกเฉพาะในแถว 
  นําเมาสไปวางดานหนาของแถวที่ตองการ ใหเมาสเปลี่ยนรูปเปนลูกศรสีดําทึบ ดังรูป แลวคลิก  หรือ

คลิกเพื่อปายทบัตารางจากชองซายสุดแลวลากเมาสไปทางขวา 
 
การเลือกเฉพาะคอลัมน  
  นําเมาสไปวางดานบนของคอลัมนที่ตองการ ใหเมาสเปลี่ยนรูปเปนลูกศรสีดําทึบ ดงัรูป แลวคลิก  
หรือคลิกที่ตารางบนสุดของ Column นั้น แลวลากเมาสลงมา 

การเลือกเฉพาะตารางทีต่องการ 
  กด CTRL คางไว แลวคลิกไปทีละชอง (เซลล) ตามตองการ 
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Table property 
  หลังจากที่เลือก Table แลวมาดูคาตางๆใน Property inspector วาสามารถกําหนดคาอะไรไดบาง 

Table Id :  ตั้งชื่อไวเรียกอางอิง 
Rows :  สามารถเพิ่มจํานวนแถวไดโดยพิมพตัวเลขเพิ่มเขาไป 
Cols :   สามารถเพิ่มจํานวน Columns ไดโดยการเพิ่มจํานวนตวัเลขเขาไป 
W และ H :  ความกวางและความสูงของตาราง  
                    - ถาความกวางถูกเซ็ตหนวยเปนเปอรเซ็นหมายถึง ส่ังให Browser ปรับขนาดของ    
                      ตารางตามความกวาง 
                      ของหนาจอ ซ่ึงจะทําใหความกวางของตารางไมแนนอน  
    - ถาระบุเปนหนวย Pixel เปนการบังคับใหขนาดของตารางที่สรางไมเปลี่ยนแปลง 
Cell Pad :  ชองวางระหวาง Cell กับตัวอักษรในเซลลนั้นๆ ปกติมีคาเปน 1 
Cell Space :  ชองวางระหวาง Cell ปกติมีคาเปน 1 
Align :   กําหนดชิดซาย กลางหรือขวา 
Border :  ขอบของตาราง 
Bg Color :  สีพื้นหลังของตาราง 
Bg Image :  ใชรูปเปนพื้นหลังของตาราง 
Brdr  :  สีของขอบของตาราง 

การกําหนดความหนาของเสนขอบตาราง 
1. เลือกตารางทั้งตาราง 

 
 

 
 
 

1 
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2. กําหนด Border ใหมีความหนาตามตองการ (มีหนวยเปน pixel) 

การกําหนด Cell Padding  
Cell padding คือ คาท่ีใชในการกําหนดขนาดความสงูของเซลลท้ังหมดในตาราง ทําไดโดย 
1. เลือกตาราง 

2. กําหนด Cell Pad ตามตองการ (ในทีน่ี้ กาํหนด CellPad เปน 2) 

 
3. ความสูงของทุกเซลล จะถูกปรับขึ้น ดังรูป 

การกําหนด Cell Spacing 
Cell Spacing คือ คาที่ใชในการกําหนดระยะหางระหวางเซลล ภายในตาราง ทําไดโดย 
1. เลือกตาราง  

2 
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2. กําหนด CellSpace ตามตองการ (ในที่นี้ กําหนด Cell Space เปน 10) 

 
3. ระยะหางระหวางเซลลจะเพิ่มขึ้น ดังรูป 

 
การกําหนดรูปแบบและเพิ่มสีสันใหกับตาราง 
1. สรางตารางและพิมพขอมลู 

 
2. คลิกเมาสในตาราง (เซลลใดก็ได) 
3. เลือกเมนูคําสั่ง Commands  Format Table  
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4. จะได Dialog box ดังรูป 
 

 
การกําหนดคณุสมบัติของรปูแบบตาราง (Format Table) 
สวนที่ 1 : Row Colors ใชกําหนดสีของแตละแถว 

 ชอง First ใชกาํหนดสีของแถวที่ 2 
 ชอง Second ใชกําหนดสีของแถวที่ 3 
 ชอง Alternate ใชกําหนดวา จะสลับสีของแตละแถวอยางไร 

– do not alternate (ไมตองสลับสี) ตั้งแตแถวท่ี 2 ลงมา จะใชสี First 
– Every Other Row   สลับสีแบบแถวตอแถวไปเรื่อยๆ 
– Every Two Rows   สลับสีทุก 2 แถว 
– Every Three Rows สลับสีทุก 3 แถว 
– Every Four Rows   สลับสีทุก 4 แถว 

สวนที่ 2 : Top Row ใชกําหนดคุณสมบัตขิองตัวอักษรและสีของแถวบน 
 ชอง Align ใชกําหนดตําแหนงของตัวอักษร ใหชิดซาย กึ่งกลาง หรือชิดขวาของเซลล 
 ชอง Text Style ใชกําหนดแบบอักษร ใหเปนแบบธรรมดา ตัวหนา ตวัเอียง ทั้งหนาทัง้เอียง 

 กําหนดการสลับสีของแตละแถว 

 กําหนดคุณสมบัติของ 
 แถวบน 

 กําหนดคุณสมบัติของ 
 คอลัมนแรก 

เลือกรูปแบบของตาราง             ภาพของรูปแบบที่เลือก    
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 ชอง Bg Color ใชกําหนดสีของเซลลในแถวบน 
 ชอง Text Color ใชกําหนดสีของตัวอักษรในแถวบน 

สวนที่ 3 : Left Col ใชกําหนดคุณสมบัติของตัวอักษรในคอลัมนแรก  
 ชอง Align ใชกําหนดตําแหนงตัวอักษรในคอลัมนแรก ใหชิดซาย กึ่งกลางหรือชิดขวาของเซลล 
 ชอง Text Style ใชกําหนดแบบอักษรในคอลัมนแรก ใหเปนแบบธรรมดา ตัวหนา ตวัเอียง ทั้ง
หนาทั้งเอยีง 

สวนที่ 4 : ชอง Border ใชกําหนดความหนาของเสนขอบตาราง 
สวนที่ 5 : ชอง Option หากเช็คเครื่องหมายถูก หมายความวา ให Dreamweaver สรางโคด (Code) เพื่อ
กําหนดคาคุณสมบัติตางๆ ในชองเซลลแตละเซลล แทนที่จะกําหนดคณุสมบัติรวมกบัแถว 
 
Property inspector ของ Row, Column และ Cell 
 
 

 
 

Property สวนบน จะเปนการควบคุมตัวอักษรหรือรูปภาพที่นํามาใสในตารางเหมือนกับ Property ของ Font  
Property สวนลาง เปน Property ที่ควบคุมตารางในสวนของ Row Column Cell 
   W และ H :  ขนาดความกวางของ Cell ไมจําเปนตองปรับ 
 No Wrap :  ชอง Wrap จะสั่งใหโปรแกรมทําการตัดคําเมื่อเจอประโยคยาวๆ  
  Header :  ทําใหชองตารางนั้นกลายเปนขอความ เหมือนสวนหวัตาราง คือ  
    สวนใหญ ตวัหนา และจัด ตาํแหนงอยูกึ่งกลางเสมอ 
  Bg :   การนํารูปภาพมาทําเปนพื้นหลัง 
  Bg:   เลือกสีทําเปนพื้นหลังถาเลือกรูปภาพแลวไมตองเลือกสี 
  Brdr :   เลือกสีของขอบพรอมทั้งขนาดของขอบ 
 
 
 
 

         ขนาดของหัวขอ      รูปแบบตัวอักษร               ขนาด     สี        ตัวหนา/เอียง   ชิดซาย/กึ่งกลาง/ขวา 

        Merge/Split  เซลล     ความกวาง(W)/สูง(H)   เลือกสีพื้น รูป          สีเสนขอบของตาราง  
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Merge Cell การรวม Cell 
 1. Select Cell ที่ตองการรวม 
 2. มาที่ Property Inspector แลวคลิกรวม Cell  

3. หลังจากคลิกรวม Cell 
ตัวอยาง การรวมเซลลที่อยูคอลัมนเดียวกัน 
 
 
 
Split Cell การแบง Cell 
1. Select Cell ที่ตองการแบง Cell โดย กด Ctrl คางแลวคลิกภายใน Cell 

2. มาที่ Property inspector คลิกที่ Splits cell 

 

Merge 

Split เซลล 

Merge เซลล 
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3. จากนั้นจะม ีDialog box ใหใสคาดังนี ้

 
Split Cell Into : ใหทําการเลือกวาตองการเพิ่ม Cell ไปในทางไหน Row หรือ Columns 
Number of Rows : ระบุจํานวน Cell ที่ตองการ  
คลิก OK 

4. ถาเลือก Split Cell Into: Rows และ Number of Rows : 2 จะไดผลลัพธดังนี ้

 
หมายเหต ุจากขอ 3 ถาเลือก Split Cell Into : Columns และ Number of Columns: 4 จะไดผลลัพธดงันี้ 

  
การบันทึกและดูโฮมเพจ 

การบันทึกโฮมเพจ (Save) 
หลังจากสรางโฮมเพจมาบางพอสมควรแลว ส่ิงที่ไมควรลืมก็คือการบันทึกผลงานทีไ่ดสรางขึ้นนี้ไว

ในไฟลนามสกุล .html โดยตั้งชื่อใหสัมพนัธกับเนื้อหาภายในโฮมเพจ ทั้งนี้จะไมทาํใหเกดิการสบัสนไดใน
ภายหลัง ซ่ึงจะมีผลทําใหงายตอการตรวจสอบ และจัดการเว็บไซตอีกดวย ขัน้ตอนการบันทึกโฮมเพจมี
ดังตอไปนี ้
1. คลิกที่เมนู File > Save หรือกดปุม <Ctrl+S> 
2. เมื่อปรากฏไดอะล็อกบ็อกซ ใสช่ือไฟลของโฮมเพจ เชน aboutme.html ลงในชอง File name 
3. ดับเบิ้ลคลิกเมาสเลือกกําหนดไดเร็คทอรีท่ี่ตองการสําหรับเก็บไฟลในชอง Save 
4. คลิกปุม Save เพื่อบันทึกไฟล 
 
 



 32

ดูโฮมเพจที่สรางขึน้ดวย Browser 
ในขณะที่สรางโฮมเพจอยูนัน้ หากตองการที่จะตรวจสอบหนาตาของโฮมเพจที่สรางขึ้น สามารถ 

Preview in Browser ทําไดโดยการกด F12 ซ่ึงทําไดตลอดเวลาที่ตองการ โดยไมจําเปนตองบันทึกโฮมเพจที่
กําลังสรางไวในไฟลใด ๆ กอน  

 
การจัดการเว็บไซตเพื่อโอนยายขอมูล (Upload) ไปสู Server ของมหาวทิยาลัย 

เมื่อผูใชสรางเว็บไซตเรียบรอยไวทีเ่ครื่องคอมพิวเตอรแลว ขั้นตอนตอไปจะตอง Upload ไฟลไปสู 
Server ซ่ึงจะทําใหบุคคลภายนอกสามารถชมเว็บของเราผานอินเตอรเนต็ได โดยมวีิธีดังตอไปนี ้
หมายเหต ุการ Upload ไฟลมาท่ี Server ของมหาวิทยาลัยจากที่บานตองเลนอินเตอรเน็ตของมหาวิทยา
กรุงเทพที่จัดเตรียมไวใหเทานั้น ถาเลนอินเตอรเน็ตจาก ISP รายอ่ืน เชน KSC, CS จะไมสามารถตดิตอกับ 
Server ของมหาวิทยาลัยได 
1. คลิกเมนู Site เลือกที่คําสั่ง Edit Site จะปรากฏหนาจอดังภาพ ทําการเลอืกไซตที่เก็บโฮมเพจของเราไว 

และคลิกที่ปุม Edit ดานขวามือ 
 
 
 
 
 
 
 
 

2. หลังจากคลิกที่ปุม Edit แลวจะปรากฏหนาตาง Site Definition for homepage และคลิกที่ Tab Sheet 
Advanced คลิกเลือก Category Remote Info ตรง List box ดานขวามือขอความ Access ใหคลิกเปลีย่นจาก 
None เปน FTP และทําการตัง้คาตางๆ ดังนี้ และคลิกที่ปุม OK 

 FTP Host: tulip.bu.ac.th  
 Host Directory: /home/regular/comart/1440320115/ (เปลี่ยนเปนรหัสของแตละคน) 
 Login: 1440320115 
 Password: xxxxxxxxxxx 
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3. เมื่อตั้งคาทั้งหมดเสร็จเรียบรอยแลวคลิก OK โปรแกรมจะกลับไปที่ 

Edit Site คลิกปุม Done  
4. สวนของหนาตางดานขวามอื ขยายสวนของ File จะปรากฏ Site ที่ได

ตั้งชื่อไว ใหคลิกที่ปุม           หลังจากนัน้จะปรากฏหนาจอสําหรับ
การ Upload ดานขวาจะเปน Site ที่อยูในเครื่อง สวนดานซายจะเปน 
Remote Server ที่ไดตั้งคาไวเรียบรอย 

5. คลิกที่ปุม             Connect โปรแกรมจะตดิตอกับ Server ที่ไดตั้งคา
ไว ถาติดตอสําเร็จจะแสดงไฟเขียวใหเห็น  

6. สรางโฟลเดอรที่ Remote Site โดยคลิกที่ 
/home/regular/comart/1440304291/ จะปรากฏแถบสีน้ําเงิน และ
คลิกเมนู File เลือกคําสั่ง New Folder พิมพช่ือโฟลเดอร 
public_html ซ่ึงจะเปนโฟลเดอรหลักไวสําหรับเก็บเว็บเพจทั้งหมด 
ดังรูป 
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7. คลิกเลือกไฟลที่ตองการ Upload จาก Local Folder (กดปุม Shift คางเพื่อเลือกไฟลพรอมกันหลายไฟล) 
จะปรากฏแถบสีน้ําเงิน คลิกเมาสคางและลากไปดานซาย Remote Site ที่โฟลเดอร public_html  

 

 
 

 
 
8. เมื่อ Upload เสร็จเรียบรอยแลวที่โฟลเดอร public_html ของ Remote Site ก็จะมีช่ือไฟลที่เรา Copy ลง 

โดยที่ไฟลจาก Local Folder ยังคงอยูเหมือนเดิม  
9. ทดสอบจากโปรแกรมบราวเซอรคือ Internet Explorer โดยพิมพช่ือเวบ็ไซต  

http://tulip.bu.ac.th/~รหัสนักศึกษา (ไมตองมี www) ตรงชอง Address และตรวจสอบสวนที่
เชื่อมโยงไปยงัเพจอื่นๆ วาทาํงานถูกตองหรือไม ภาพที่ใสลงไปขึ้นครบหรือไม ถายงัไมถูกตองกลับไป
แกไขใหเรียบรอย และ Upload ใหมอีกครั้ง เพียงเทานีค้นทั่วโลกก็จะสามารถเรียกดูเว็บไซตของเราได 
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การแกไขเพิ่มเติมเว็บไซต 
 ในกรณีที่ผูใชงานตองการออกแบบแกไขเพิ่มเติมจากเวบ็เดิมที่ไดออกแบบไวแลว โดยใชเครื่อง
คอมพิวเตอรเครื่องใหมที่ไมไดบันทึกขอมูลของเว็บผูใชงานไวตั้งแตเร่ิมแรกนั้น มวีธีิการดังตอไปนี้ 

1. เมื่อเปดโปรแกรม Dreamweaver แลว ผูใชสรางไซตใหมเพื่อกําหนดโฟลเดอรในการจัดเก็บ
ขอมูลลงเครื่องใหเหมือนกบัที่กําหนดในครั้งเริ่มแรก สามารถดูขั้นตอนไดจากหนาที่ 7 

2. กําหนดคา Remote Info เพื่อติดตอกับ Server สามารถดูขั้นตอนไดจากหนาที่ 32 
3. Connect เขาสู Server โดยคลิกที่ปุม Connect             โดยตองแนใจวาไดติดตอกับระบบ

อินเตอรเน็ตแลว เมื่อ Connect เรียบรอยแลวจะปรากฏหนาจอดังรูป 

 
4. Copy ขอมูลจาก Server ซ่ึงอยูดานซายมือ มาไวที่ไซตซ่ึงกําหนดไวตอนแรก ซ่ึงการ Copy 

หลายไฟลพรอมกันใหกดปุม Shift ที่คียบอรดคางไว และคลิกที่เมนู Edit > Copy  

 
5. จากนั้นนําเมาสไปคลิกไซตดานขวามือดังรูป และคลิกที่เมน ูEdit > Past ในขณะทีก่ําลัง 

Copy จะปรากฏหนาจอขึ้นมาถามวาตองการ Copy ไฟลอ่ืนที่เกี่ยวของหรือไมใหคลิก Yes  
 
 
 
 

 
 

1 

2 

หากพบวาหนาจอเปนเครื่องหมาย + ใหคลิกที่
เครื่องหมายก็จะปรากฏไฟลทั้งหมดที่เก็บไวในไซต 

คลิกที่ปุมนี้เพื่อกลับไปสูหนาจอการออกแบบเว็บไซต 


